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1  What is UVS Remote 600?

UVS Remote 600 is your Windows-based PC tool for remote control of one or several UVS
600 Vibration Monitors.

The program is also used for down- & uploading of files (measurement data, program
updates) from and to UVS 600 instruments and your PC.

All functions are available via regular telephone line, mobile GSM communication, as well
as through direct cable connection (RS232).

The UVS Remote 600 program file (called UVS06R.exe) contains two versions of the
program:

• Standard, with all remote control functions included

• Light, for file transfer only.

Both versions will be installed on your PC, and you can select which version to use from
time to time.

The UVS Remote 600 program comes on a CD-ROM delivered with your UVS 600
instrument(s). Future updates will be available on ABEM´s website www.abem.com.
Please contact ABEM for the current password.

1.1  Hardware requirements for using UVS Remote 600

1.1.1 Remote connection
At the place of the operator:

•  A PC with Microsoft Windows® 95/98 or NT4, and a VGA screen.

• A modem connected to the regular telephone network

or

• A
 GSM telephone capable of data communication installed as modem in Windows.

At the measurement location:

• At least one UVS 600 Vibration Monitor.

• A GSM System for UVS 600 (ABEM Part No. 20 3906 00) installed in each
instrument

or

• A modem, including power supply, connected to the regular telephone network.

1.1.2 Direct cable connection

• A PC with Microsoft Windows® 95/98 or NT4, and a VGA screen.

• One UVS 600 Vibration Monitor.

• A modular cabel set, as included in the instrument package.
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2  Installation of UVS Remote 600

• If the program is installed from disk, place the first UVS Remote 600 disk in drive A
or B and run SETUP.EXE from the disk.

• If the software is loaded from the Internet, use the Windows Explorer to run
UVSR600.EXE to unpack the installation files. Then run SETUP.EXE to install the
software.

• If the program is installed from CD, place the CD in the drive and run SETUP.EXE
from the CD.

Once the screen shows the UVS Remote 600 Setup window, installation is self-
explanatory.

• During the installation of the program, files are copied to the directory chosen by the
program. System files for Visual Basic and Microsoft Access will be copied to the
Windows system directory.

• When installation is complete, a shortcut named “UVS Remote 600” will appear in the
“UVS” group under “Programs” in the Windows Start menu.

Figure 1 - UVS Remote 600 Setup window



  UVS Remote 600

- 4 -

3  Setting up your UVS 600 instrument for remote
communication

3.1 Null Modem

The Null Modem is the easiest way to use UVS Remote 600.

1. Connect the UVS 600 to the PC using the modular cable set, which was included in the
shipping of our UVS 600.

2. Start the UVS 600 by pressing the LCD key on the instrument.

3. Open the Modem menu on the UVS 600 by pressing the MENU button repeatedly.

4. If the modem parameter is set to ON, press the F1 button and alter  the modem parameter to
OFF by pressing the + button.

5. Press F2 to save the new settings.

6. Exit the UVS 600 by pressing the LCD key twice.

The UVS 600 is now ready for use. UVS 600 will start automatically when it receives
commands from the PC.

3.2 GSM Modem

If your UVS 600 is equipped with a  GSM System , it can be contacted via GSM.

1. Set the mode switch of the UVS 3901 GSM Communication Unit to 2-WAY COMM.

2. Start the UVS 600 by pressing the LCD key on the instrument.

3. Open the Modem menu on the UVS 600 by pressing the MENU button repeatedly.

4. If the modem parameter is set to OFF, press the F1 button and alter  the modem parameter to
ON by pressing the + button.

5. Press F2 to save the new settings.

6. Wait while the UVS 600 initiates the modem.

7. If the initiation is successful, exit the UVS 600 by pressing the LCD key twice.(If the initiation
fails please contact ABEM for support.)

The UVS 600 is now ready for use. UVS 600 will start automatically when it receives a
call from the PC.

3.3 Tele Modem

The use of tele modem is currently not supported by UVS 600.
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4  Running UVS Remote 600 (Standard mode)

4.1 Start the program

UVS Remote 600 can be run in Standard mode or in Light mode. The Light mode is a
minimum version of UVS Remote 600 for transfer of datafiles only. The Light mode is
described in chapter 4.

If you do not want to communicate with your instrument(s) via modem you may skip this
chapter and go directly to chapter 4.

To run UVS Remote 600 in Standard mode:

1. Select the UVS Remote 600 shortcut from the UVS group under windows in the
Windows Start menu.

2. Click the Standard mode button of the start-up window.

Figure 2 -UVS Remote 600 start-up window
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4.2 Main window (not connected)

The main window of UVS Remote 600 will appear after starting the program
(see Figure 3).

The menu bar at the top of the main window is described in chapter 6. The first time you
run UVS Remote 600 you may want to set up your environment. To do this you enter the
setup menu of the menu bar (see chapter 6.2).

There are several textboxes and buttons on the main window. When UVS Remote 600 is
not connected to an instrument, only the Connect button on the last row is enabled.

Figure 3 - UVS Remote 600 main window (not connected)
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4.3 The instrument database

All instruments to be used must be entered into the instrument database. The database is
opened by clicking the Connect button.

4.3.1 Buttons
CALL Initiates the modem and calls the instrument chosen.

CANCEL Exits the database window without calling an instrument.

NEW Provides a blank record, with Serial Number as the active field.
Information on a new instrument can now be entered.

UPDATE Updates the database with the new entries.

DELETE Removes the record shown.

4.3.2 Database fields
Serial Number

Instrument serial number, must always be filled in. It is used in the communication
between your PC and the instrument. To select an instrument from the database, click on
the list button, then double click on the instrument you want to choose. You can also type
the serial number in the box. The serial number must be the “short form” (3- or 4-digit)
number that appears on the LCD (not the full 6-digit number on the S/N panel).

Phone Number

Telephone number to the instrument. For direct connection with the modular (RS232)
cable, leave this field blank. If UVS Remote 600 is used with a mixture of GSM-connected

Figure 4 - Instrument database setup window
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instruments and normal modem-connected instruments, it is recommended that the full area
codes are always entered for all instruments.

Device

The type of communication device of the instrument. If a direct cable is used, select
NULL. Selecting the wrong device will make it impossible to communicate with the
instrument. Information from this field will be used to select whether the PC will use the
communication port selected in the NullModem frame or the modem selected in the
Modem frame. The NullModem and the Modem frames are found on the PC-Setup
window as described in chapter 6.2.1.

Data Directory

The path to the directory in which your measurement data will be stored. This field must be
filled in before you can transfer data. UVS Remote 600 proposes the following path:

C:\(Program directory)\DATA\ (Instrument S/N).

You can also select a path by clicking the list button to the right and choosing existing
drives and directories.

Location

Text field (e.g. for project identification).

Text 1-4

Text field for optional use.

4.3.4 Calling an instrument
After you have chosen an instrument, click on the CALL button with the mouse. A new
“dialing window” comes up. The window shows information about the dialing process.

If a GSM modem is used at the UVS 600 end, UVS Remote 600 will make several retries
before stop calling. If the line is busy, the modem will hang up after 3 seconds. A
CANCEL button is available if you want to hang up manually.

Figure 5 - Dialing window
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4.4 Main window (connected)

The title bar (above the menu bar) gives you the UVS Remote 600 program name along
with the status of the modem connection.

• [not connected] UVS Remote 600 is open, but no instrument has been
called.

• [101, connected] Contact has been established and the instrument (number 
101) is ready for communication with the PC.

• [101, connected, busy] Instrument number 101 has been called, but there is 
no contact with the instrument. The instrument might be 
busy (recording an event), or the instrument at this 
telephone number is not number 101.

4.4.1 The main window frames
The main window is divided into four framed sections.

Last registration:

In the upper part of this frame the time, date, and corresponding data is shown for the last
registered event that exceeded any of the thresholds at the time of the registration.

Figure 6 - UVS Remote 600 main window (connected to instrument S/N 101)
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UVS 600 Instrument:

On the first row of this frame, one can see and modify the threshold settings of the
connected UVS 600.

This frame shows information about program version, serial number, calibration date, and
battery status of the connected UVS 600.

Clicking the Optional Power button opens a window with information about optional
power units.

If the instrument connected to UVS Remote 600 is using a GSM modem, clicking the
RSSI (Radio Signal Strength Indicator) button will show information about the GSM
signal strength at the instrument.

Clocks:

By clicking the Read-button, the clock times of the PC and the instrument are entered into
the boxes. Please note that this information is not automatically updated.

When registration is OFF, the clock of the instrument can be set to the time of the PC-clock
by clicking the Synchronize-button

Registration status:

When connected to an instrument, the text “Registration is ON” or the text “Registration
is OFF” becomes visible to reflect the registration status of the connected instrument.

In case the sensor connection is broken an Input Error message will appear here.

Figure 8 - RSSI window

Figure 7 - Optional power window
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4.4.2 Download measurement data
Clicking the Download measurement data button will start the downloading of
measurement data from the connected UVS 600 to the PC. UVS Remote 600 will ask were
to save the file with measurement data, suggesting a filename in the data directory
specified in the instrument database.

Figure 9 - Save as dialog

A window will show the progress of the file transfer.

A successful downloading is completed by a confirmation dialog.

Figure 11 – Transfer confirmation window

Figure 10 – File transfer window
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5  Running UVS Remote 600 (Light mode)

5.1 Start the program

UVS Remote 600 can be run in Standard mode or in Light mode. The Light mode is a
minimum version of UVS Remote 600 for file transfer via RS 232 cable only (it does not
include remote control of instruments). The Standard mode is described in chapter 4.

To run UVS Remote 600 in Light mode:

1. Select the UVS Remote 600 shortcut from the UVS group under windows in the
Windows Start menu.

2. Click the Light mode button of the start-up window.

5.2 Main window

In light mode the main window of UVS Remote 600 contains two buttons.

5.2.1 Download measurement data
1. Enter the UVS 600 serial number in the Serial number text field on the first row of the

main window.

2. When the Download measurement data button is clicked UVS Remote 600 will try to
contact the UVS 600 instrument.

If UVS Remote 600 succeeds in contacting the UVS 600, the measurement download
operation will continue as described in 4.4.2.

Figure 12 -UVS Remote 600 start-up window

Figure 13 – Light mode main window



  UVS Remote 600

- 13 -

5.2.1 Loading new software into instrument
1. Enter the UVS 600 serial number in the Serial number text field on the first row of the

main window.

2. When the Load new software into instrument button is clicked UVS Remote 600
will try to contact the UVS 600 instrument.

If UVS Remote 600 succeeds in contacting the UVS 600, the software upload process will
continue as described in 6.1.2.

When trying to connect to a UVS 600, the PC will use the communication port selected in
the NullModem frame of the PC-Setup window as described in 6.2.1.

Please note that the serial number entered in the Serial number text field is used in the
communication between the PC and the instrument, and must agree with the serial number
of the instrument.
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6  The menu bar

6.1 File

The File menu has three possible choices:

Figure 14 – The File menu

6.1.1 Download measurement data
Download measurement data has the same function as the Download measurement
data button of the main window. If the program is connected to a UVS 600 instrument, the
measurement database will be downloaded to the PC and saved to file as described in 4.4.2.

6.1.2 Load new software into instrument
If the program is connected to an instrument, and if the instrument registration is OFF, you
can select Load new software into instrument. This enables you to upload new software
from the PC to the connected UVS 600. Before the uploading process starts it must be
confirmed through a dialog.

Figure 15 – Software upload dialog
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If the uploading process is continued, the file containing the new UVS 600 program must
be selected.

If a valid program file is selected an information window shows version number and
compilation date of the selected file.

If the selected program file is accepted the uploading process starts. A window that shows
the progress of the process appears. First a memory area in the instrument must be cleared
for the new software to be loaded into.

Figure 16 – Selecting UVS 600 program file

Figure 17 – Program information window
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When a memory area in the UVS 600 has been cleared the actual uploading starts.

When the new program file has been transferred to the UVS 600, the program is checked
for errors which might have come up during the transfer.

If the new program file has been properly transferred, the reprogramming must be
confirmed once more before the actual reprogramming starts.

If the reprogramming is confirmed, the instrument starts switching to the new program.

Figure 18 – Clearing memory area in UVS 600

Figure 19 – Software uploading

Figure 20 – Testing program file checksum

Figure 21 – Reprogramming confirmation
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6.1.3 Exit
You can select Exit to leave the UVS Remote 600 program.

6.2 Setup

The Setup menu  has two possible choices:

Figure 23 – The Setup menu

6.2.1 PC Setup
The PC Setup opens a window used to setup the PC for UVS Remote 600 communication.

Figure 22 – Reprogramming instrument

Figure 24 - PC Setup window
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Nullmodem frame:

Selects communication port for the direct cable connection.

Modem frame:

This frame is enabled only when UVS Remote 600 is run in Standard mode. From the
Modem frame one of the installed modems can be selected. UVS Remote 600 retrieves all
necessary information about the modem (com port, setup strings etc.) from the Windows
registry. If no modem is installed in the PC, the text  “No modem found” will appear.

Options frame:

This frame is enabled only when UVS Remote 600 is run in Standard mode.

Dialing Prefix:

This information will be added prior to all telephone numbers (e.g. “0W” to call
out via an office switchboard).

Alt. Init-string:

To set an alternative initiation string to the modem, this string must begin with
“AT&F.”. To add parameters to the initiation string, this string must begin with
“+”. The modem strings retrieved from the Windows registry is normally enough
and does not need to be changed.

Max BaudRate:

To limit the baud rate used for communication with the modem or via the Null
modem cable, the maximum allowable baud rate can be entered here.

Debug Mode:

The debug mode is intended for problem tracing and should be used by support
personnel only.

6.2.2 Language
The language menu opens a dialog box used to choose among installed language files.

Figure 25 - Language setup window
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You can create your own language files. To do this just copy an existing file from the
“languages” directory in the directory were UVS Remote 600 was installed. Name the new
language file “newLanguageName.txt” and open it with a text editor (e.g. Notepad). The
language files consists of two columns separated by “=”. In the left column there are
English words and expressions framed with dollar signs ($). In the right column there are
translations of the words and expressions. The translations are also framed with dollar
signs. A line in a German language file (deutsch.txt) could look like:

$word or sentence $=$Wort oder Sats$

When creating your own language files, please be careful not to use the same shortcut letter
more than once in the same menu or panel. A shortcut letter is any letter in the language
file preceded with an ampersand (&-character).

If the new language file is placed in the “languages” directory, you can select it from the
language setup window the next time UVS Remote 600 is run.

6.3 Options

The Options menu has two possible choices:

Figure 26 – The Options menu

6.3.1 Refresh
The Refresh menu updates all information from the connected UVS 600. This is useful if
some information failed to be read from the UVS 600 as contact was established (e.g. due
to poor connection).
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6.3.2 About
Choosing About will show information of the program version and copyright.

Figure 27 – About window

6.4 SMS

Figure 28 – The SMS menu

6.4.1 SMS messages
The SMS menu is only available when UVS Remote 600 is run in Standard mode. It is
used for setting up the SMS function of the UVS 600.

When a measured value of the UVS 600 has exceeded a threshold value (and the SMS
function is ON, see below), an SMS message will be sent to all active receivers.
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The SMS message consists of nine text lines. Figure 29 shows an example of how an SMS
message could look.

• “LOCATION A” The location string of the UVS 600 SMS setup.

• “UVS601-0164” Instrument type and serial number.

• “Sa 16 Dec 2000” Date of the event.

• “13:09” Time of the event.

• “3.7 mm/s”, “3.1 m/s2”, “16 um” Measured magnitudes in the three different units.

• “Bat: 12.68 VS” Battery status of the instrument.

• “<!MDS;0;D0;UVS601;0164!>” Event identity string to be used by a measurement
data server.

Most GSM operators will deliver an SMS message within 30 seconds.

Figure 29 – Example of SMS message
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6.4.2 SMS Setup window
By clicking the SMS menu, the SMS Setup window is opened.

The PC frame to the left in the window is used for editing the SMS setup of the
instrument. After editing the setup must be transferred to the UVS 600. This is made by
clicking the right arrow. If it is the first time the instrument receives SMS parameters, it
will take a while.

Default information to the PC frame can be copied from the remote UVS 600 by using the
left arrow, or from the PC by clicking the From Disk button.

To save the PC frame for later use, click the To Disk button. The PC can only save one set
of SMS parameters.

SMS Operator:

The protocol used by tele modems to send SMS messages is called UCP.

If your UVS 600 is using a tele modem (please refer to chapter 3.3), you need to enter the
phone number of the UCP gateway in this field. Your tele network administrator will
provide you with the number.

Receiver 1-8:

Up to 8 receivers can be listed, but only those with the Active button enabled will receive
SMS messages.

For both operator and receivers, a note of maximum six characters can be entered.

Location:

This field is automatically copied from the Location field of the instrument database, but
can be changed if needed.

Figure 30 - SMS Setup window
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Updated By:

Before sending the SMS setup to the UVS 600, a signature must be entered. The signature
must consist of min two and max four characters.

The UVS 600 frame displays the current SMS setup of the remote UVS 600, including
date and time for the last updating of the setup.

ON, OFF:

Use these buttons as a master activate/deactivate of the UVS 600 SMS function. The text
between the buttons will display the current status.

Many of the SMS parameter actions must be confirmed by clicking OK in message boxes
like this.

Figure 31 – Uncompleted setup

Figure 32 - SMS dialog window


